Contents

1 Introduction .................................................................................................................. 1

2 Getting Started ............................................................................................................. 1
  2.1 Installation .................................................................................................................. 1
  2.2 Importing data files .................................................................................................... 1
  2.3 NSDstat format ........................................................................................................... 2

3 Metadata ........................................................................................................................ 3
  3.1 Publisher Templates .................................................................................................. 3
  3.2 Template Manager ..................................................................................................... 3
  3.3 Template Editor ......................................................................................................... 5
    3.3.1 Creating groups ..................................................................................................... 6
    3.3.2 Adding DDI fields to a group ............................................................................... 6
    3.3.3 Setting DDI field options ................................................................................... 7
    3.3.4 Controlled vocabularies ..................................................................................... 7
  3.4 Variables ................................................................................................................... 9
    3.4.1 Categories ............................................................................................................ 9
    3.4.2 Category Hierarchy .............................................................................................. 10
    3.4.3 Useful variable information (including Weight & Time variables) ................. 10
    3.4.4 Data Types .......................................................................................................... 11
    3.4.5 Variable Documentation ..................................................................................... 12
  3.5 Variable Groups ........................................................................................................ 12
    3.5.1 Adding/removing a variable group ................................................................... 12
    3.5.2 Adding variables to a group .............................................................................. 13
    3.5.3 To copy a group .................................................................................................. 13

4 Publishing ..................................................................................................................... 14
  4.1 Adding a Nesstar Server ............................................................................................ 14
  4.2 Removing a Nesstar Server ....................................................................................... 14
  4.3 To Publish to a Nesstar Server ................................................................................ 15
    4.3.1 The Hidden catalogue ......................................................................................... 15
  4.4 Creating new catalogues ........................................................................................... 15
  4.5 Internet Publishing .................................................................................................... 16
  4.6 To Publish to a Secure Server .................................................................................. 16

5 Nesstar Publisher Menu Items ....................................................................................... 17
  5.1 File Menu .................................................................................................................. 17
    5.1.1 New ..................................................................................................................... 17
    5.1.2 Open ..................................................................................................................... 17
    5.1.3 Reopen ............................................................................................................... 17
    5.1.4 Close .................................................................................................................... 17
    5.1.5 Close All ............................................................................................................. 17
    5.1.6 Save Dataset ....................................................................................................... 17
    5.1.7 Import Dataset ................................................................................................... 17
    5.1.8 Export Dataset ................................................................................................... 17
    5.1.9 Preferences .......................................................................................................... 18
    5.1.10 Exit ....................................................................................................................... 19
  5.2 Edit Menu .................................................................................................................. 19
    5.2.1 Cut, Copy and Paste ............................................................................................ 19
    5.2.2 Copy as Text ........................................................................................................ 19
  5.3 Documentation Menu ............................................................................................... 19
5.3.1 Import from Dataset .................................................. 19
5.3.2 Import from DDI ...................................................... 20
5.3.3 Export DDI ............................................................... 20
5.3.4 Add to Local Variable Repository ............................... 20
5.3.5 Add to Global Variable Repository ............................. 20
5.3.6 Variable Repository ................................................ 20
5.3.7 Statistics Preview .................................................... 21
5.3.8 Update Statistics ..................................................... 21
5.3.9 Create Categories from Statistics ............................... 21
5.3.10 Apply Defaults From Template ................................. 21
5.3.11 Templates ............................................................. 22

5.4 Variables Menu .......................................................... 22
5.4.1 Find Variable ........................................................ 22
5.4.2 Go To ................................................................. 22
5.4.3 Add Numeric Variable .............................................. 22
5.4.4 Add Short String Variable ....................................... 22
5.4.5 Add String Variable ............................................... 23
5.4.6 Add Date Variable .................................................. 23
5.4.7 Insert Numeric Variable .......................................... 23
5.4.8 Insert Short String Variable .................................... 23
5.4.9 Insert String Variable ............................................. 23
5.4.10 Insert Date Variable .............................................. 23
5.4.11 Duplicate Variables .............................................. 23
5.4.12 Copy Variables .................................................... 24
5.4.13 Insert Copied Variables ........................................ 24
5.4.14 Resequence ......................................................... 24
5.4.15 Change Case ........................................................ 24
5.4.16 Delete ................................................................. 24

5.5 Variable Groups Menu ................................................ 24
5.5.1 Add Variable Group ................................................. 25
5.5.2 Delete Variable Group ............................................. 25
5.5.3 Delete All Empty Variable Groups ............................. 25

5.6 Data .......................................................................... 25
5.6.1 Write Protected ..................................................... 25
5.6.2 Insert Data Matrix From Dataset ............................... 25
5.6.3 Insert Data Matrix From Fixed Format Text ................ 26
5.6.4 Sort Cases .......................................................... 26
5.6.5 Delete Cases ......................................................... 26
5.6.6 Data | View ........................................................ 27
5.6.7 Data | Cubes ........................................................ 27

5.7 Publishing .................................................................. 29
5.7.1 Republish On All Servers ........................................ 29
5.7.2 The <servername> Server ....................................... 30
5.7.3 Publish Data and Metadata ..................................... 30
5.7.4 Publish Metadata Only .......................................... 30
5.7.5 Republish ............................................................ 30
5.7.6 Manage Server .................................................... 30
5.7.7 Log out ................................................................ 30
5.7.8 Remove Server ..................................................... 31
5.7.9 Add Server ........................................................ 31

5.8 Tools ....................................................................... 31
5.8.1 Hierarchy Builder .................................................. 31
5.8.2 Cube Builder ........................................................ 33

5.9 Window .................................................................. 33
5.9.1 Cascade .............................................................. 33
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.9.2</td>
<td>Arrange Icons</td>
<td>33</td>
</tr>
<tr>
<td>5.10</td>
<td>Help</td>
<td>34</td>
</tr>
<tr>
<td>5.10.1</td>
<td>Homepage</td>
<td>34</td>
</tr>
<tr>
<td>5.10.2</td>
<td>View Licence</td>
<td>34</td>
</tr>
<tr>
<td>5.10.3</td>
<td>Support</td>
<td>34</td>
</tr>
<tr>
<td>5.10.4</td>
<td>Submit Bug Report</td>
<td>34</td>
</tr>
<tr>
<td>5.10.5</td>
<td>Submit Feature Request</td>
<td>34</td>
</tr>
<tr>
<td>5.10.6</td>
<td>About</td>
<td>34</td>
</tr>
</tbody>
</table>
1 Introduction
The Nesstar Publisher is a data and metadata authoring tool that is used to prepare
and publish survey and tabular (cube) data for the Nesstar system. Alternatively it
can be used as a stand alone data processing tool. Metadata, consistent with the
DDI (Data Document Initiative) standard, can also be produced without the need for
familiarity with XML.

Nesstar Publisher can be used to:

• Add metadata to a survey or cube
• Convert a dataset to the Nesstar format or other data formats
• Publish a dataset and metadata to a Nesstar Server
• Publish cubes (tabular data) to a Nesstar Server
• Prepare hierarchically related datasets for the Nesstar system
• Manage the resources on a Nesstar Server

2 Getting Started

2.1 Installation
The Nesstar Publisher requires a licence key for installation and activation. This only
needs to be entered once even if you uninstall the product and then reinstall, or
install a new version, as the licence key is saved in the registry of the operating
system.

Once installed there are a number of options within File | Preferences that you may
wish to set. These include:

• File Locations – You can specify the default location for each of the following
directories: Temp, Dataset, Import, Export, DDI
• Proxy Settings – Enter details here if you access the Internet through a
proxy server. The settings entered here should be the same as those found in
your web browser.
• Global Variable Repository – If you specify a directory in this field any
information saved to it will then be available to other Publisher users,
assuming they have the necessary access rights. This is particularly useful if
you have standard category labels that are used in a number of datasets

For more information see 5.1.9 Preferences below.

2.2 Importing data files
Nesstar Publisher can import data in the following formats:

• DDI Document (*.xml)
• SPSS System (*.sav)
• SPSS Portable (*.por)
• SPSS Syntax (*.sps)
• SAS (*.sp1)
• Stata 7 and Stata 8 (*.dta)
• Statistica (*.sta)
• NSDstat (*.nsf), the old NSDstat format used by NSDstat Pro.
Importing datasets:
Please note that when importing files from a remote file system, files may become corrupt or errors may be reported by Publisher. We therefore recommend that files are used locally and then copied to the relevant storage area when complete.

To import a dataset:

1. Go to File | Import Dataset.
2. Locate the file you wish to import
3. Select the type of file you are importing from the drop down box
4. Click ‘Open’
5. To save the file use File | Save Dataset or click [Save]

Note: When importing XML files the newly created file will only contain the metadata for a study. Data may be imported using the ‘Insert Data Matrix From Fixed Format Text’ option if the layout of the data is the same as in the imported DDI XML file, i.e. the StartCol and EndCol details match the inserted data.

2.3 NSDstat format
The NSDstat file format has two variations:

- Prior to 2002 the NSDstat format consisted of 3 files (‘.nsf’, ‘.dkm’, ‘.ind’ files)
- The current NSDstat format is made up of only one file

To import data and metadata using the older format:

1. Go to File | Import Dataset and select the ‘.nsf’ file to import
2. Select ‘NSDstat (.nsf) as the file type
3. Click ‘Open’
4. To import metadata, choose Documentation | Import from DDI
5. Select the sections of the DDI to import and click ‘OK’
6. Locate the XML file associated with this data and click ‘Open’
3 Metadata
The Nesstar Publisher enables information (metadata) to be added to a study or table using the standards established by the Data Document Initiative (DDI) (http://www.icpsr.umich.edu/DDI).

For other resources such as Adobe PDF files, or Microsoft Word documents, Dublin Core or e-GMS (e-Government Metadata Standard) elements are used.

Further information about e-GMS can be found at: http://www.govtalk.gov.uk/schemasstandards/

3.1 Publisher Templates
Publisher uses ‘Metadata templates’ to create a structure for the information that is used to describe a resource. Each template consists of a selected number of metadata fields which are then completed by the person publishing the dataset. There are two types of template:

- **Study Templates** - used to select the relevant DDI fields required when documenting a study and related data files
- **Resource Description Templates** – used to select the Dublin Core/e-GMS elements required to document other types of resources, and found within the Resource Publisher.

Default templates for both are supplied and these can be customised as required.

Templates containing specific fields for a data series can be created so that the same fields are always used for that series. This will then ensure consistency across datasets regardless of who actually creates the metadata.

**Note:** Changes made to a template are to assist with the input of metadata. None of the changes made to field names, or the order in which they are presented, will be reflected on the Nesstar Server.

3.2 Template Manager
To open the Template Manager go to Documentation | Templates or select T.

The Template Manager is used to create, edit, delete, import, and export templates.

The Template Manager window contains a list of templates that are currently available. The highlighted template is the ‘active template’, i.e. the template that is currently in use. In the example below, ‘Nesstar Template’ is the one that is currently active.

When a template is selected, information about it will be displayed in the ‘Description’ window immediately below the template list.
The Template Manager contains a list of options on the right-hand side:

**Use**
This option allows users to switch between different templates. To use:

1. Select a template from the ‘Templates’ list.
2. Click ‘Use’ to make it the active template.
   This closes the Template Manager, and the Publisher’s dataset editing windows are rebuilt according to the active template’s structure.

**New**
1. Click ‘New’ to create a template.
2. The Template Editor window appears.
   See 3.4 Template Editor for further information.

**Edit**
1. Select a template from the ‘Templates’ list.
2. Click ‘Edit’ to open the Template Editor and edit as necessary.
   See 3.4 Template Editor for further information.
Note: You cannot edit the Default template directly. If you wish to create a template based on the Publisher’s Default format, select the User Template from the templates list displayed in the Template Manager.

Delete
1. Select a template from the 'Templates' list.
2. Click ‘Delete’ to remove the selected template.

Note: The Default template cannot be deleted.

Import
The Publisher produces '.NSDStatTemplate' files when a template is exported (see below). Use the Import function to use a previously exported Template file. This is useful if you wish to produce metadata using a particular template. To use:

1. Click ‘Import’.
2. Locate the template file and click ‘Open’.
3. Click ‘OK’ to proceed. Click ‘Edit’ if you wish to give the template a new name.

Note: The imported template cannot have the same name as a template already listed in the 'Templates' list. If a template name already exists the Publisher displays a warning and renames the imported file (usually by adding a number to the end of the file name).

Export
Use the Export function to produce a '.NSDStatTemplate' file which other users can import back into the Publisher. If multiple users wish to use the same template, this function will prevent them from having to create new templates individually. To use:

1. Select a template from the Templates list.
2. Click ‘Export’.
3. Give the template a new name, if required, and select a location in which to save it.
4. Click ‘Save’.

Close
Click ‘Close’ to exit the Template Manager.

If the active template is edited, the dataset editing windows are rebuilt accordingly when the Template Manager is exited.

Help
Click ‘Help’ to display the Publisher’s help file.

3.3 Template Editor
The Template Editor enables the user to edit a template. To access the Template Editor:

1. Open the Template Manager by clicking Documentation | Templates or by selecting the Templates button on the toolbar.
2. Select the template that you wish to change and click the ‘Edit’ button.
3. The Template editor will then open.
4. Click on the ‘Description’ tab to enter metadata about the template.
   a. The ‘Description’ field in the Template Manager displays the information you enter.
   b. All fields are optional except the name field.
   c. The template names must be unique. If you enter a name that is already in use, the text is shown in red and the ‘OK’ button is disabled.

5. Click on the ‘Content’ tab to change the content of the template.
   a. You can select different metadata fields from the DDI and organise them into groups.
   b. Multiple options for each DDI field can be set, e.g. default values, noting that some fields, such as those containing dates, have restricted options.
   c. Fields that are marked with a ‘DC’ in the DDI tree, that is visible in the Template Manager, are fields that map to the Dublin Core. Fields marked with ‘R’ are those recommended by the DDI Committee (See http://www.icpsr.umich.edu/DDI/ for further information).

**Note:** Changes made to the content of the ‘Name’ and ‘Custom Label’ fields within a template are to assist with the preparation of metadata and will only be effective within the Publisher. Once a dataset/resource is published, the original DDI field names are used as headings within the metadata, and the order in which they are displayed within WebView, is fixed.

### 3.3.1 Creating groups

1. Click on the ‘Content’ tab of the Template Editor window.
2. The left-hand window shows a series of tabs: Document Description, Study Description, File Description, and Variable Description.
3. Select one of these tabs and add a group to it by using the plus [+] button.
4. Use the minus [-] button to delete a group.
5. Use these groups to organise the DDI fields in the template under the different tabs.

### 3.3.2 Adding DDI fields to a group

To add DDI fields to a group:

1. Click on a group.
2. On the right in the ‘Available Items’ window is a list of DDI fields that can be added to the group.
3. The ‘Item Description’ window displays information outlining what the selected item is.
4. Select an item and use the << button to add the field to the group. Alternatively double-click on an item or drag and drop it from the ‘Available Items’ window to the required group.
5. Select a field and click on the >> button to remove it from a group. Alternatively, select an item and use the delete key.
6. Use the ‘up’ and ‘down’ arrow buttons to move the selected item to the required position within the template.

**Note:** There is a limit on the number of fields that can be placed in a group because of the restriction in available screen space. A warning message will appear when a group is full.

### 3.3.3 Setting DDI field options
For most DDI fields the following options can be set:

**Custom Label**
By default this is set to be the same as the Original Label but can be edited to make it more user-friendly. For example, your organisation may know the DDI field ‘Authoring Entity’ as ‘Author’ so your name can be entered into this field. Users entering information into Publisher within your organisation would then see a familiar field name.

**Note:** The ‘Original Label’ field cannot be changed.

**Mandatory**
This is a check box which can be used to denote whether a particular field is mandatory. A red ‘M’ is visible by the relevant field name in the left-hand window when this box is checked.

**Fixed**
Check this box if users are able to view the field but are not able to alter it. This allows the template creator to exercise control over the template and prevent other users from making changes to these fields if they import this template.

**Description**
When this tab is selected information about the chosen item will be displayed.

The ‘Original Description’ section displays information provided by the DDI. This includes a description of the field and details on its recommended use.

The ‘Custom Description’ section enables you to add your own information relating to your use of this field. The description entered here will appear in the Publisher. This is particularly useful if there is something specific about a field that the person preparing the dataset needs to know, as any information entered here will be visible to them.

**Defaults**
Click this button to enter default text/values for this field.

**Note:** Default text is not added to a study or a variable until you ‘Apply defaults from template’ or create a new dataset or variable. All new variables and studies will contain the default text.

### 3.3.4 Controlled vocabularies
A controlled vocabulary list can be created for many items in your template and is basically a pre-defined list of terms that are available for a given field.
When adding metadata, information can then be selected from a list of pre-defined
terms that are available for that field. This helps to ensure consistency in the use of
terms across studies, and assists in the searching and retrieval of information once
the dataset has been published.

To create a controlled vocabulary list:

1. Select a field within your template.
2. Click on the ‘Controlled Vocabulary’ tab in the ‘Item Description’ pane.
3. Enter text in the controlled vocabulary field.
4. Press ‘Enter’ or click on to enter more terms.
5. Reorganise your terms using the arrow buttons.
6. To remove terms from your list use the button.
7. Any information added is automatically saved for that field within your
   template.

**Controlled Vocabulary - Keyword and Topic Classification fields:**
The ‘Topic Classification’ and ‘Keywords’ fields support a ‘hierarchically’ structured
controlled vocabulary. The controlled vocabulary for these fields is created and used
in a slightly different way.

**Note:** The information entered into the fields ‘Vocabulary Name’ and ‘Vocabulary
URI’ is added to the dataset for every keyword.

**Creating a hierarchy for a controlled vocabulary list:**
Specify a ‘Vocabulary Name’ and/or a ‘Vocabulary URI’ if required. Then:

1. Select a field to add a controlled vocabulary term.
2. Click on (plus) to create a new level to the hierarchy.
3. Use to add new levels and use to remove them.
4. Change the position of different levels of the hierarchy by clicking on a level
   icon and using the up and down arrow buttons.
5. To change the name of a level:
   a. Select the level.
   b. Click on (edit Item text button) and type in a new name.

Click ‘OK’ to retain the changes. Click ‘Cancel’ to discard changes to a template
without saving them. This closes the Template Editor and the template reverts to its
previous state.
Using a controlled vocabulary list:

To use the items from a controlled vocabulary list click on + for the relevant field within the Study Description section of the Publisher and a new window will open containing the list of available terms, see below:

Select items by clicking on them and then pressing 'Add'.

3.4 Variables

Metadata for each variable (e.g. category values, category labels, category text, data type and measure type) can be added in the ‘Variables’ section. Variable metadata fields are found in the 'Variables Description' section.

To add and edit variable information:

1. Click on the ‘Variables’ tab.
2. Select a variable from the variables list.
3. Add and/or edit variable information in the 'Variable Description' section.

3.4.1 Categories

To add or change variable categories:

1. Click on ‘Categories' in the Variable Description section.
2. Specify a category value and label for the selected variable.
3. Use **Documentation | Update Statistics** to update the current view in the preview pane.

4. Select ‘Statistics’ in the ‘Documentation’ menu to see a preview.

Note: You can add ‘Category Text’ for categories to provide more information about that category or to elaborate on the response categories. Please note that category text information is added to the DDI XML file but is not currently displayed in Nesstar WebView.

### 3.4.2 Category Hierarchy

It is sometimes useful to create a category hierarchy for particular variables. This is particularly useful when preparing tabular or Cube data which often include a spatial variable/dimension that contain a natural hierarchy. For example, an area may contain ‘Districts’ as part of a ‘Local authority’.

Within Publisher, the hierarchy structure consists of ◀ and ▶ icons that correspond to variable/dimension categories.

To create a hierarchy within an existing variable or dimension:

1. Select the category, or categories, to be moved by clicking on a category, or by using the ‘ctrl’ key and selecting the required categories.
2. Drag the category or categories to the category under which they are to be nested.
3. Release the mouse button.

To create a hierarchy including new categories:

1. Click on ‘Category Hierarchy’ under Variable Description.
2. Select a category ◀ and click on plus ▶ to add a new lower level folder.
3. Use minus ◄ to delete items from the hierarchy.
4. Enter value and label information.
5. Enter the name of the level at which the variable exists in the hierarchy in the ‘Level Name’ field. For example, District or Local Authority.
6. Additional categories can be created by using the plus button.
7. Categories can be moved between levels by dragging and dropping using the mouse.

The ‘GeoMap URI’ field is used to add a link to a suitably prepared map. Please see the Cube Guide, available from Nesstar Support, for information on how to link to maps.

### 3.4.3 Useful variable information (including Weight & Time variables)

1. Click on ‘Variable Information’ to hide and reveal the available fields.
2. Specify the ‘Data Type’ and ‘Measure’ of the variable with the drop-down combination boxes.
3. Check the 'Is Weight Variable' option to assign weighting status to the active variable. Variables marked as weighting variables will then be shown when the ‘Weight’ icon is selected in Nesstar WebView.
4. Check the 'Is Time Variable' checkbox if the variable is to be used to be treated as a 'Time' variable, i.e. to use the time series graphing option.
5. Specify a minimum and maximum value for the active variable in the input fields.
6. Specify decimal places in the 'decimals' input field.
7. Check the ‘implicit decimals’ box if the ‘Insert Data Matrix From Fixed Format Text’ function was used to import a file and the file contains decimals. Leave the box clear if decimals are not present.
8. Values for which there are missing data can be specified with operators from the available drop-down combination box. The ‘..’ operator activates the second field and enables you to specify a range of values.

3.4.4 Data Types
The variable type is displayed in the ‘Data Type’ field. It is possible to convert a variable from one type to another by selecting a different type from the list available. This is particularly useful if you wish to convert an alphanumeric variable into a numeric variable, and to retain the alphanumeric information as the category label.

To convert the data type of a variable:

1. Select the 'Variables' tab.
2. Click on a variable from the variables list.
3. Go to the Variable Information panel at the bottom right of the window.
4. The ‘Data Type’ box displays the data type of the active variable. Click on the drop-down list to see the available data types.
5. Select a data type from the list.
6. If prompted for conversion information, select the appropriate option(s), e.g. By order of appearance, Alphabetical, Custom, and then rearrange as necessary.

**Fixed strings**
A fixed string is a string with a predefined length which can be set in the ‘String Length’ field below the ‘Measure’ box. Using fixed string variables is very CPU efficient as the strings are stored in an array and are fast to store and retrieve. A fixed string variable uses the same character set/encoding as the machine it runs on. A fixed string can be from 1 to 255 characters in length.

**Dynamic strings**
A dynamic string is a string with no limitation on its length, as the string adapts itself to what is stored in it. Each cell is stored as a separate object in the file and it is therefore much less efficient to store than fixed strings and takes more time to retrieve many objects than a single array as in the case of fixed strings. However, unlike fixed strings, empty cells are not stored. Dynamic string stores strings in Unicode format and should be used when you only have a few cells containing information and the content are long strings. Dynamic string should not be used if the strings are less than 20 characters in length.
3.4.5 Variable Documentation

Information relating to specific variables can be selected or added in the ‘Documentation’ section of Publisher. Select the relevant tab (see below) to add information as required:

![Documentation Tabs]

**Statistics:**
Items selected here will be displayed for each variable, if relevant, when viewing the variable information under the ‘Description’ tab in Nesstar WebView.

**Weights:**
Use this option to assign weights to specific variables. This then enables weighted statistics to be viewed if the ‘Include weighted statistics’ option is also checked under the ‘Statistics’ option above.

**Documentation:**
Metadata fields available in the active Template will be shown under this heading, e.g. Literal Question, Interviewers instructions, variable notes. By selecting this tab information can then be added to these sections. This information will then be shown when the variable is selected in Nesstar WebView.

3.5 Variable Groups

Variable groups typically consist of variables that share given characteristics. They may, for example, contain responses to a single question or refer to the same topic or broad topic area. They also reduce the load time of a dataset once it is published.

Variables can be grouped in certain ways to allow easier navigation. For example, all variables in a survey associated with questions on political affiliation can be grouped under the title ‘Party identification’.

**Note:** Variables are automatically added to a default group if they are not specifically allocated to a variable group. The default group is represented by ‘...’ in Nesstar WebView.

3.5.1 Adding/removing a variable group

To create a variable group:

1. Select the Variable Groups tab.
2. Click on ‘Variable Groups’ in the left panel called ‘Groups’.
3. Click on ![to create a group](image) to create a group and a new group ![will appear](image).
4. Enter a name for the group.
5. In the right panel, ‘Group parameters’ select ‘Description’ and enter further information under each heading as required. Click on ![to add an external link](image) if required.

To remove a variable group:
Select a group by clicking on its name, then click on ![to remove it](image).
3.5.2 Adding variables to a group
To add variables to a group:

1. Click on a variable group
2. Select ‘Variables’ under ‘Group parameters’.
3. Click on plus + to open a new window containing a list of all the variables in the dataset.
   **Note:** If plus is not active it may mean that a variable group is not selected.
4. Select the variables to add to that group by clicking on a variable, or by using the ‘ctrl’ or ‘shift’ keys to select multiple variables.
5. Click ‘OK’ to add the selected variables to the selected group.

Use ‘Find’ to search for a variable. Use ‘Select’ to search for specific text within a variable. Variables found to contain the search criteria are highlighted and selected. The highlighted items are added to the specified variable group selected at the outset.

3.5.3 To copy a group
To copy variable groups:

- Click and drag while pressing Ctrl to create a copy of a variable group.
- Click and drag while pressing Shift to create a group that replicates all actions performed in the original group. This type of group is denoted by a blue variable group icon.

Any action taken on any replicated variable group is immediately replicated for any copies. This includes renaming the group and adding and deleting variables.

A replicated variable group is blue. Any groups created below a replicated variable group are represented by a green variable group icon.
4  Publishing
Data can be published to a specified Nesstar Server by using the Publishing menu. This menu allows servers to be added or removed. The required server will need to be added if it is not listed. It is possible to publish to servers both locally and over the internet.

4.1 Adding a Nesstar Server
You can publish to a server installed on your own machine, to a remote server accessed through a Local Area Network (LAN) or to a server on the internet.

- Choose Add server… from the Publishing menu

To add a local server (on your own machine or a remote server accessed through a Local Area Network):
  - Select ‘Server on a local network’.
  - Click on ‘…’ to browse for the location of the server.

To add a server on the internet:
  1. Select ‘Server on internet’.
  2. Enter the URL of the server with the port number on which it is running, for example http://nesstar.essex.ac.uk:80.
  3. Enter a user name and password with publishing rights.
  4. Click ‘OK’.

This adds the server location to the Publishing menu.

4.2 Removing a Nesstar Server
Choose Publishing | The <ServerName> Server | Remove Server.

This deletes the server with the title <ServerName> from the list of servers available for publishing.
4.3 To Publish to a Nesstar Server

1. To publish a dataset, choose a server to publish to from the Publishing menu. A server must be added if none is available (see 4.1 Adding a Server).
2. Select whether to ‘Publish data and metadata’ or to ‘Publish metadata only’.
3. Enter a user name and password with publishing rights if prompted and click ‘OK’.
4. Select one or more catalogue(s), or the ‘Hidden’ catalogue to publish to by ticking the appropriate checkboxes (see below on how to create new catalogues).
5. Alternatively, click on a catalogue name and click on ‘+’ to expand the selected catalogue.

Note: When catalogue names match ‘Keywords’ or ‘Topic Classification’ terms, and the Nesstar Server has been appropriately configured, the Publisher will automatically select the catalogues for publishing. The catalogues are listed under ‘Selected Catalogues’.

To deselect a catalogue:
- Untick its checkbox or click on the catalogue title in the ‘Selected Catalogs’ section of the dialogue box and click on the minus ‘-’ button.

6. Click ‘Publish’.
7. An animation box indicates that information is being published to the chosen server. A message appears when publishing has been successfully completed.
8. It is also possible to view a published file via the Publisher. When a file has been successfully published, the option to ‘Open in Web client’ will be available. This will, by default, be set to ‘webview’.

Note: If you are using a customised Web client then you need to enter the name of that client. To set the Web client for your server click and enter the name of your web client, then click ‘OK’

You require the necessary permissions and access rights to be able to publish to a remote server.

4.3.1 The Hidden catalogue
A ‘Hidden’ catalogue that is not visible to users is available. This is particularly useful if you wish to publish a resource and check it before making it publicly available.

The ‘Hidden’ catalogue can be selected to publish to in the same way as other catalogues. It is also possible to create other catalogues within it as described below.

Once a resource has been published to this special area you will need to view it using the ‘Open in Web client’ option. Once opened, the URI to this resource, or the Hidden catalogue, can then be copied and shared with other users.

4.4 Creating new catalogues
Catalogues can be created at the root level or within other catalogues.
To create new catalogues:

2. Click on the ‘Catalogs’ tab.
3. Click on the plus button (+) to add a new catalogue.
4. Give the new catalogue a name.
5. Use the arrow buttons if you need to rearrange the position of the catalogues.

To remove a catalogue:

1. Select a catalogue.
2. Click on minus (-).

The ‘Published Resources’ tabbed section provides a way to generate lists of items published on the server.

4.5 Internet Publishing

Internet publishing offers two advantages over remote publishing and is recommended for most other publishing:

1. It is easier to set up because no sharing of directories is required, and
2. It has added security because no directories are shared.

Once Nesstar Servers have been added to the Publisher, data and metadata can be published in the usual way, regardless of whether the server is accessed locally through a LAN or via the internet.

Tip: Large datasets (greater than 100 Mb) should be published over a Local Area Network (LAN) for faster performance rather than via an internet connection.

4.6 To Publish to a Secure Server

To publish to a server that is configured to run only on secure sockets you need to add the security certificate to the publisher. One way to import the certificate is to:

1. Copy the ‘nesstar.cer’ file from the Nesstar Server ‘config’ directory.
2. Paste it into the main Publisher directory.
3. Run the ‘importcert.bat’ script that is provided with Nesstar Publisher.

Note: Publishing to a secure server will not work over a local network. When adding the server you must check the ‘Server on Internet’ option and enter the server location in full including the server’s port number (see 4.1 Adding a Server for details).
5 Nesstar Publisher Menu Items

The following is a comprehensive reference list of each menu item in Nesstar Publisher. Information is offered on what the item is, what it does and how it can be used.

5.1 File Menu

5.1.1 New
The ‘New’ dataset function is accessible through the File menu, the toolbar button □, and by pressing Ctrl+N. This function creates a new file in the Publisher.

5.1.2 Open
The ‘Open’ dataset function is accessible through the File menu, a toolbar button □, and by pressing Ctrl+O using the keyboard.

1. Go to File | Open.
2. Locate the ‘.NSDstat’ file and click ‘Open’.

The file opens in the Publisher.

5.1.3 Reopen
The ‘Reopen’ dataset function is accessible through the File menu where a list of the recently used datasets is available. The keyboard shortcut Ctrl+L opens the most recently used file.

5.1.4 Close
Choose ‘Close’ from the File menu to close the active dataset.

5.1.5 Close All
Choose ‘Close All’ from the File menu to close all open datasets.

5.1.6 Save Dataset
The Save dataset function is accessible through the File menu, the toolbar button □, and by pressing Ctrl+S on the keyboard. Choose File | Save dataset to save the file with its existing name to whichever drive is currently in use.

5.1.7 Import Dataset
Nesstar Publisher supports the import of datasets from the most common statistical formats. (See 2 Getting Started above).

5.1.8 Export Dataset
Nesstar Publisher supports the export of datasets to various statistical formats (see 2 Getting Started above).
To export a dataset:

1. Choose File | Export dataset.
2. Specify a location to which you wish to save the file.
3. Choose the file type you wish to export to.
4. Click ‘Save’.

5.1.9 Preferences
Choose ‘Preferences’ under the ‘File’ menu. The following functions are available under Preferences.

File Settings
Alter the preferences for five different directories.

Note: If no files have been used previously, the default location is the Publisher installation directory.

Temp Directory
Use this option to specify where temporary files, generated by the Publisher, are placed. The default setting is to “Use Windows' temp directory”. If the option for the default setting is unchecked, browse and select an alternative directory of your choice.

Dataset Directory
This option specifies the location for ‘.NSDstat’ files. The default location is the last visited directory. To change this, uncheck the option and select the desired directory.

Import Directory
This option specifies the location from which files are imported. The default location is the directory from which files were last imported. To change this, uncheck the option and select the desired directory.

Export Directory
This option specifies the location to which files are exported. The default location is the directory to which files were last exported. To change this, uncheck the option and select the desired directory.

DDI Directory
This option specifies the location from which DDI files are imported. The default location is the directory from which DDI files were last imported. To change this, uncheck the option and select the desired directory.

Proxy Settings
If you access the internet through a proxy server you must use the available fields to enter the proxy settings exactly as they appear in your web browser. To see this information using Internet Explorer, go to: Tools | Internet Options | Connections tab | LAN Settings button | Advanced button. Enter the address and port information for HTTP or SOCKS proxies as appropriate. You may need to contact your Network Administrator to do this.

If proxy information is not set correctly, publishing functions may not work.
**Global Variable Repository**
Use this option to specify a location from which you can share category sets with others. This Variable Repository will not allow access to the Global Repository until a location has been specified. Enter a variable location or click on the browse button to search. Confirm your selection if prompted.

**5.1.10 Exit**
Choose ‘Exit’ from the ‘File’ menu to shut down the Publisher. If there are any open datasets with unsaved changes, a Save prompt will appear before the programme closes.

**5.2 Edit Menu**

**5.2.1 Cut, Copy and Paste**
Cut, copy, paste and select all have the same functionality as in other Windows applications.

**5.2.2 Copy as Text**
The 'Copy as text' function is available from the Edit menu, by pressing Ctrl+Alt+C, and by right-clicking with the mouse. This function is only accessible when 'Data Entry' is the active tab.

This function copies the *label* of the selected variable regardless of whether labels or values are displayed.

To use the 'copy as text' function:

1. Select the Data Entry tabbed section.
2. Click in a cell and click on **Edit | Copy** as text or right-click with the mouse, or press Ctrl+Alt+C.
3. The value for the relevant cell is copied and can be pasted using the paste function.

To copy the value, use Copy.

**5.3 Documentation Menu**

**5.3.1 Import from Dataset**
Use 'Import From Dataset' to reuse all or specific elements of the metadata from other '.NSDstat' files.

1. Select 'Import from Dataset' and choose the '.NSDstat' file from which to import information.
2. Click 'OK'.

See [2 Getting Started](#) above for more information.
5.3.2 Import from DDI
The ‘Import From DDI’ function works in the same way as the ‘Import From Dataset’ function, except that it imports from DDI XML files instead of ‘.NSDstat’ files. Measures and Statistics options are not imported because they are not part of the DDI.

To import metadata from a DDI File:

1. Go to File | New to create a new file.
2. Click Documentation | Import from DDI.
3. Check the options of the DDI you wish to import.
4. Click ‘OK’.
5. Locate the XML file you wish to import and click ‘Open’.

See 2 Getting Started above for more information.

5.3.3 Export DDI
Use DDI Export to export the metadata of a given dataset and save it as an .xml file. The complete DDI is generated.

If you wish to use the DDI files in systems other than Nesstar any accompanying data should be exported as ASCII to maximise the chances of compatibility with other systems.

Go to File | Export dataset.
Set the ‘save as type’ to fixed format ASCII (*.dat).
Click ‘Save’.

5.3.4 Add to Local Variable Repository
Use this function to add variables to the local variable repository thus allowing the information to be used for similar variables in other datasets. The keyboard shortcut is Ctrl+Alt+L.

5.3.5 Add to Global Variable Repository
Use this function to add variables to the global variable repository thus allowing the information to be shared with others and used for similar variables in other datasets. The keyboard shortcut is Ctrl+Alt+G.

5.3.6 Variable Repository
This option opens the complete Variable Repository, i.e. both the local and global repositories. Variables that you may wish to reuse, or share with others, can be saved here.

The local variable repository is available by default, but the global variable repository will not be available until a location for it has been specified in File | Preferences. Remember that this is to hold variables that are to be used by others so please make sure it is created somewhere that is accessible by those that need access to it.

It is also possible to create groups within the repository so that variables can be found more easily.
To create a variable repository group:

1. Choose **Documentation | Variable Repository**
2. Right-click on 'local variable repository', or 'global variable repository' if available.
3. Create a group and add the appropriate information.

Different types of variables are denoted by $\text{[I]}$ for numeric variables and by $\text{[S]}$ for short string variables.

To add the categories from a variable in a variable repository to the variable that is currently active in Publisher:

1. Select the required variable in the repository.
2. Click on ‘Use’, and the categories will be added to the active variable.

### 5.3.7 Statistics Preview
A preview pane is available at the bottom of the Publisher window when the Variables tab is active. Enable the Statistics Preview option to see summary information about the selected variable.

### 5.3.8 Update Statistics
Click on this option to update the information shown in the statistics preview pane (when it is enabled). For example, if you change or add information relating to value labels or categories for a given variable, the new information is not displayed until you use the Update Statistics function.

### 5.3.9 Create Categories from Statistics
Use this option to automatically generate categories from the data for non-scale variables. This is useful for variable requirements when creating cubes.

### 5.3.10 Apply Defaults From Template
When a new dataset is created, the default values from the currently active template are automatically added to dataset documentation. When an existing dataset is open the default text is not added to the dataset.

To ‘Apply Defaults From Template’ to apply the defaults from the active template to an existing dataset:

1. After adding default text to a template using the **Template Editor**, close the Template Manager and go to **Documentation | Apply defaults from template**.
2. Choose from the submenu whether you wish to apply the defaults to all fields or just to empty fields, and the defaults from the active template will be applied to the dataset.

**Note**: The ‘Apply Defaults From Template’ function also applies to the variable documentation. Any default text you enter will **not appear until you use the apply defaults function or create a new variable or dataset**. If you subsequently edit the
template and make changes to the default text, you will have to use the apply
defaults function again before the changes are applied.

Default text is not automatically applied as different users can apply different
templates to the same dataset

5.3.11 Templates
The Publisher has a default template which determines which DDI fields are
available. You can add or remove fields as required at any time using the Template
Editor and the Publisher’s main dataset editing window will be updated accordingly.

(See 3.2 Templates for more information).

5.4 Variables Menu

5.4.1 Find Variable
To use the ‘Find variable’ function to quickly locate variables using a search term:

1. Click Variables | Find Variable or press Ctrl+F.
2. Enter a search term in ‘search text’.
3. Check the options with which to conduct the search.
4. Click on a search result to view the relevant item in the variables list.

5.4.2 Go To
To use the ‘Go To’ feature to jump directly to a given variable:

1. Choose Variables | Go To or press Alt+G.
2. A small text box opens. Enter a variable number.
3. Click ‘OK’ to view the chosen variable in the variables list.

5.4.3 Add Numeric Variable
Use the ‘Add numeric variable’ function to store any number, integer and floating
point. It is recommended for use with categorical data.

- Choose Variables | Add numeric variable.

The variable is added at the bottom of the variable list.

5.4.4 Add Short String Variable
Use this option to add a fixed length (8 characters) string type variable to a dataset.
Only the ASCII character set can be used.

- Choose Variables | Add short string variable.

The variable is added at the bottom of the variable list.
5.4.5 Add String Variable
Use this option to add a string variable. String variables are Unicode compatible with no limitation on length. These variables can be used, for example, when responses to open-ended questions need to be recorded.

- Click on Variables | Add string variable.

The variable is added at the bottom of the variable list.

5.4.6 Add Date Variable
Use the ‘Add date variable’ function to enter date variables in the ISO date format (YYYY-MM-DD) into the dataset. It is possible to enter a full date, year and month, or just a year.

- Click on Variables | Add date variable.

The variable is added to the bottom of the variable list.

5.4.7 Insert Numeric Variable
Use ‘Insert numeric variable’ function to insert a variable in the highlighted position.

- Click on Variables | Insert numeric variable.

5.4.8 Insert Short String Variable
Use this option to insert a short string variable into the highlighted position.

5.4.9 Insert String Variable
String variables are Unicode compatible with no limitation on length. Use this option to insert a string variable into the highlighted position.

5.4.10 Insert Date Variable
Use the ‘Insert date variable’ function to insert a date variable into the highlighted position.

5.4.11 Duplicate Variables
To use the ‘Duplicate variables’ function to duplicate the metadata for the selected variable:

1. Click on Variables | Duplicate variables.
2. The duplicated variable appears at the bottom of the list in the Variables view and at the far right of the list when the Data Entry tab is active.

This function is useful where there are blocks/groups of questions/variables that are quite similar and are repeated several times. The ‘Duplicate Variables’ function allows these blocks of variables to be repeated so that they do not have to be entered individually.
5.4.12 Copy Variables
Use the ‘Copy variables’ function to copy variables with their definition and their documentation across datasets or within a dataset. Everything is copied excluding the data.

5.4.13 Insert Copied Variables
Use the ‘Insert Copied Variables’ function to insert the variables that have been selected by the Copy Variables function. The copied variables are inserted at the highlighted position in the variables list and can be altered as necessary.

5.4.14 Resequence
The ‘Resequence’ function recalculates the Start Column and End Column positions for the variables from information in the Widths column. For example, if a variable has a width of 4 and a start column of 16, the end column will be 19 (i.e. the width of 4 spans 16, 17, 18 and 19).

1. Click on Variables | Resequence.
2. The Publisher recalculates the Start Column and End Column positions for all the variables.

**Note:** To use this function all variables must have a defined width.
**Tip:** SPSS Syntax export requires all variables to have the width defined.

5.4.15 Change Case
To use the ‘Change case’ function to alter the appearance of the text of variable names, variable labels and category labels:

1. Click on Variables | Change Case.
2. Name, label, category labels, and category text can be set to standard sentence form, all in lowercase or all in uppercase.
3. Select the required options.
4. Click ‘OK’.

5.4.16 Delete
Click this option to delete the selected variable when either the Variables tab or the Data Entry tab is active. You are asked to confirm that you wish to delete the selected variable before the operation is executed.

5.5 Variable Groups Menu
Variable groups are used to cluster variables that share given characteristics. They may, for example, be responses to a single question or refer to the same topic or broad topic area.

Variable groups are produced in the Publisher under the ‘Variable groups’ tab. (See 3.6 Variable Groups above for more information.)

The functions on the Variable Groups menu are only available when the variable groups tab is active.
5.5.1 Add Variable Group

1. Click on Variables | Add variable group.
2. This adds a variable group at a lower level than the root

5.5.2 Delete Variable Group

1. Select the variable group you wish to delete.
2. Choose Delete Variable Group from the Variables menu.

5.5.3 Delete All Empty Variable Groups

- Click on Variables | Delete all empty variable groups

All empty variable groups are deleted.

5.6 Data

5.6.1 Write Protected

Select ‘write protected’ to control whether or not data can be edited under the data entry tab.

To turn the write protected feature on and off, and to edit data:

1. Go to Data | Write Protected.
2. A tick in the checkbox indicates that the data are write protected and cannot be edited. Remove the tick to be able to edit the data.

Note: If the data matrix is compressed, it is decompressed when write protection is disabled for the first time and you may need to wait a short time for this to occur. You can then enter new text in the last row. This pause whilst the Publisher is busy occurs only once and is not repeated as you move on to enter information into additional cells.

You are only permitted to enter valid category values here for the variable in question. Any illegal text is coloured red and cannot be entered. If you have completely new categories, please ensure that you enter value and label information for this new category in the Categories section under the Variables tab and then use the newly assigned values in Data Entry.

5.6.2 Insert Data Matrix From Dataset

If a documented dataset does not contain any data, use ‘Insert data matrix from dataset’ to import a file containing the data matrix from another dataset. The following file types can be imported: NSDstat dataset (’.nsdstat’), SPSS (’.sav’ and ‘.por’), Stata (’.dta’), Statistica (’.sta’), NSDstat (’.nsf’), dBase (’.dbf’), Dif (’.dif’), Delimited Text (’.txt’ and ‘.csv’).
This is particularly useful if the original data file has been divided up into several parts, for example, one file for each country in a cross-national survey. Note that this function can only be used where the datasets have the same number of variables. In addition, each variable in the source dataset has to match the data type of the variable in the destination dataset.

This function could also be used to delay the inclusion of data until the documentation has been completed. To use:

1. Click on **Data | Insert data matrix from dataset**.
2. Locate the required file and click ‘open’.
3. Choose to replace the existing dataset or to append the new data to the end of the data matrix.

### 5.6.3 Insert Data Matrix From Fixed Format Text

Use this function when the imported DDI has the location information defined. The StartCol and EndCol must be defined for the variables.

On importing a dataset from a DDI XML file, the metadata will be extracted and a new file without any data will be created. Use the ‘Insert Data Matrix From Fixed Format Text’ function to import the data if the layout of the variables is the same as in the imported DDI file. To use:

1. Click on **Data | Insert data matrix from fixed format text**
2. Locate the required file and click ‘open’.
3. Choose to replace the existing dataset or to append the new data to the end of the data matrix.

### 5.6.4 Sort Cases...

The ‘sort cases’ feature is available when the 'Data Entry' tab is active. This feature enables you to organise cases by variables and control the data display under the 'Data Entry' tab.

To sort cases:

1. Click on the 'Data Entry' tab.
2. Click **Data | Sort Cases**.
3. Select the variable you wish to sort by from the 'Variable to sort by' dropdown list.
4. Use the second dropdown list to specify a sort order e.g. ascending.
5. Click ‘OK’ to apply the changes.
6. Repeat the process to sort by additional variables. If you add more variables to sort by, the earlier variables take priority.
7. Remove any of the variables by clicking on the minus (-) button next to it.

### 5.6.5 Delete Cases

The 'Delete Cases' item is available from the Data menu when the 'Data Entry' tab is active tab.

To delete specific cases:
1. Click **Data | Delete Cases**.
2. A dialogue box opens that allows specified cases to be deleted. You may choose to delete:
   a. The current case
   b. All cases
   c. A range of cases (e.g. cases from 12 to 36)
   d. A selection of cases relating to a particular variable (e.g. cases where variable 1 has a value lower than 6)
3. Choose the case(s) you wish to delete and click 'OK'.
4. This deletes the cases specified.

5.6.6 **Data | View**

5.6.6.1 **Adjust Column Widths To Category Labels**
Use this to change the width of the columns under the Data Entry tab to display the labels and/or names in full.

5.6.6.2 **View Labels**
Select ‘View Labels’ to display the labels for each category in the data matrix.

5.6.6.3 **View Values**
Select ‘View Values’ to display the actual values for each category in the data matrix.

5.6.6.4 **View Variable Names**
Select this function to display the variable name only in the data matrix.

5.6.6.5 **View Variable Names & Numbers**
Use this function to view both the variable name and the variable number at the top of each column in shown under the Data Entry tab. Adjust the width of each column accordingly using the ‘Adjust column widths to category labels’ function on the same menu.

5.6.6.6 **View Variable Numbers**
Use this function to display the variable number only at the top of each column in the data display shown when the Data Entry tab is active.

5.6.7 **Data | Cubes**

5.6.7.1 **Expand Dimension**
This function can be used to add new categories of data to dimensions in a data cube. However, it is possible to use the ‘Insert Data Matrix From Fixed Format Text’ option if you want to insert a file that contains exactly the same number of variables/dimensions and measures as the open file. For example, one file contains information for one year and you want to add another file containing the same information for another year.
To use Expand Dimension:

1. Select **Data | Cubes > Expand dimension**.
2. Use the drop down list to select a dimension to expand.
3. Enter value and label information as required.
4. Click ‘OK’.

Example:
The data cube below has the dimensions Sex (M, F), Year (1999, 2000), Country (Norway, Sweden, UK), and a measure – ‘Income’.

To add further income data for the year 2001:

1. Click on **Data | Cubes > Expand Dimension**. The ‘Expand Dimension’ box opens.
2. Click on the dropdown list and select ‘Year’ as the dimension to expand.
3. Enter ‘2001’ in both the value and label fields.
4. Click ‘OK’.
5. New cases are added at the end of the matrix as shown.

<table>
<thead>
<tr>
<th>Sex</th>
<th>Year</th>
<th>Country</th>
<th>Income</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>2001</td>
<td>Norway</td>
<td>*</td>
</tr>
<tr>
<td>F</td>
<td>2001</td>
<td>Sweden</td>
<td>*</td>
</tr>
<tr>
<td>F</td>
<td>2001</td>
<td>UK</td>
<td>*</td>
</tr>
<tr>
<td>M</td>
<td>2001</td>
<td>Norway</td>
<td>*</td>
</tr>
<tr>
<td>M</td>
<td>2001</td>
<td>Sweden</td>
<td>*</td>
</tr>
<tr>
<td>M</td>
<td>2001</td>
<td>UK</td>
<td>*</td>
</tr>
</tbody>
</table>

The function creates new rows in the data with all the permutations of the new category combined with the categories on the other dimensions. It will also create new rows in the data with all the combinations for the new category, and add the new category to the category list for the expanded dimension.

**Note**: The actual data on these measures must be entered into the data matrix and cannot be imported using the Insert Data Matrix function.

### 5.6.7.2 Measures to Dimension

This option can be used if you are preparing cube data and have a table that contains a large number of measures that you wish to treat as one dimension. If you have a number of dimensions already in your table, using the NesstarExporter Excel macro will not work as the Excel limits on table size will soon be reached. Using this option within Publisher is therefore very useful.

Example:
The table below shows a few rows from a much larger table containing information for a number of years, and for a number of areas. It also contains a number of columns of information that we want to treat as another dimension, e.g. ‘Pop-Total’, ‘Did not work’, ‘Worked’, and ‘Worked-part year’.
To prepare the above table for Nesstar:

1. From Excel save this table in tab or ‘csv’ format.
2. Import into Nesstar Publisher. You will then find that all column headings are now listed as variables in Publisher. The columns containing numerical information will be treated as separate measures if the cube is left as it is. To make these ‘measures’ into a dimension.
3. Select Data | Cubes > Measure to Dimension.
4. Select the Measures to be categories in the new variable/Dimension, e.g. in the above table you would select ‘Pop-Total’, ‘Did not work’, ‘Worked’ and ‘Worked-part year’.
5. Click ‘OK’ and new Dimension and Measure variables will be created. These will be labelled ‘Merged Dimension’ and ‘Merged Measure’.
6. Rename the new Dimension and Measure variables as required.

5.7 Publishing

5.7.1 Republish On All Servers

If servers have been added (see 4.1 Adding a server), use this function to republish the same study to all available servers simultaneously.

Use republishing when you want to republish existing studies/resources and want them to remain in their existing Nesstar catalogues.
5.7.2 The <servername> Server
When a Nesstar Server has been added using the ‘Publishing | Add Server’ option a list of available Nesstar servers will be listed. Each available Server will then have a link to a submenu containing further options as described below:

5.7.3 Publish Data and Metadata
To publish data and metadata:

1. Select a Nesstar Server.
2. Select ‘Publish data and metadata’.
3. Enter a user name and password with publishing rights if prompted.
4. Select one or more catalogue(s) to which you want to publish
5. Click on 'Publish'.

A message appears when publishing has been successfully completed.

5.7.4 Publish Metadata Only
This function operates in the same way as ‘Publish data and metadata’ but publishes only the metadata.

5.7.5 Republish
Use 'Republish' to republish an existing study in its original catalogue.

5.7.6 Manage Server
The Server Administrator may use this function to create and organise catalogues under the default catalogue. This function will not be available until a server has been added to the Publisher.

1. Click on Publishing | The <ServerName> Server | Manage Server.
2. Enter a user name and password with publishing rights if prompted.
3. Click on the plus (+) button to add a new catalogue.
4. Give the new catalogue a name and click 'close'.
5. To change the order of the catalogues, select a catalogue and use the Up and Down arrow buttons to change its position.
6. To change a catalogue name, simply click on it and type new text in the 'name' field displayed in the 'Manage server' box.

5.7.7 Log out
This function is found on the Publishing menu where a server has been added.

For security reasons the Administrator needs to log in to the publisher to be able to publish and to access the 'Manage Server' function.

Click Publishing | The <ServerName> Server | Log Out to prevent unauthorised users from accessing these controlled features.
5.7.8 Remove Server
To remove a Nesstar Server:

1. Go to Publishing | The <ServerName> Server | Remove Server.
2. This deletes the server with the title <ServerName> from the list of servers available for publishing.

5.7.9 Add Server
To add a Nesstar Server:

1. Click on Publishing | Add server....
2. A dialogue box called 'Add Server' appears.
3. Enter a URL to locate a server on the internet (e.g. http://nesstar.essex.ac.uk:80) or browse for the location of the server if it is on a local network.
4. Enter the Server administrator name and password.
5. Click 'OK'.

The server is now added to the Publishing menu (see also 4.1 Adding a Server above).

5.8 Tools

5.8.1 Hierarchy Builder...
Use the Nesstar Hierarchy Builder to specify the hierarchical relationship between datasets. These datasets may contain several separate data files that have a hierarchical relationship such as large household surveys where questions may be asked not only at the household level (such as geographies or housing type) but also the individual level (such as employment history or health).

The Hierarchy Builder is used to add data files and define their hierarchical relationship at different levels. The datasets are then merged with the use of the key variables.

This is an overview of the use of the Hierarchy Builder. More information is available by clicking on Help within the hierarchy builder itself.

Adding and Deleting Levels
To add levels to the hierarchy:

1. Click Hierarchy | Add Level. Alternatively use ‘Add Level’.

To delete a level from the hierarchy:

1. Select a level and go to Hierarchy | Delete. Alternatively click on the minus button.
The option to delete a level is only available when there is more than one level in the hierarchy.

Adding and Deleting Datasets

To add datasets to the hierarchy:

1. Click on **Hierarchy | Add Datasets**…. Alternatively click on ‘Add Datasets’
3. Select the file you require and click ‘Open’.

**Note**: The file must be in the NSDstat format to be used by the Hierarchy Builder. Files of other types are supported but they will need to be converted to NSDstat by first importing them into Nesstar Publisher. It should be noted that the datasets also need to be documented in the Publisher.

The dataset is added to the active level and this is displayed in the left-hand window. In addition, the name of the added dataset is displayed in the ‘Dataset file name’ field at the top of the right-hand window. Added datasets retain their original names and these cannot be changed.

To delete datasets from the hierarchy:

Select the dataset and go to **Hierarchy | Delete**. Alternatively click on the minus button.

Adding and Deleting Base Keys and External Keys

Base key variables are the variables used to uniquely identify cases in the dataset. External key variables are the variables that need to be used as base keys to merge with the files at a higher level but not base keys in the selected dataset. The following is an example of when to use external keys:

Dataset 1 contains the base key HOUSEHOLD
Dataset 2 contains the base keys HOUSEHOLD and FAMILYNO
Dataset 3 contains the base keys HOUSEHOLD, PERSONNO and FAMILYNO

To merge Datasets 2 and 3 add the external key FAMILYNO to Dataset 3. This is because the only common variable between Datasets 2 and 3 is HOUSEHOLD and this does not form a unique identifier for either Dataset 2 or 3. Therefore a merge is not possible.

To add a base key variable:

1. Select a dataset from the left-hand window.
2. Click on the ‘+’ button that is to the right of the ‘base key variables’ field.
3. A dialogue box displays a listing of all the variables in the dataset.
4. Click on the required variable and click ‘OK’ to confirm the selection.
5. The chosen variable is added to the ‘Base key variables’ field. Please note that these variables have to be added one at a time.
Repeat the above process until the required number of variables have been added to uniquely identify a case within that dataset.

**Note**: Dataset keys must be either numeric or short string variables.

To delete any variables from the ‘base key variables’ and ‘external key variables’ fields:

1. Select the variable to be deleted.
2. Click on the '-' button to the right of the relevant field.

You can delete several variables at once.

**Choosing the Study Description Source**

All of the datasets in the hierarchy can be documented using the Publisher but only one will be used as the Study Description source for the dataset. The Hierarchy Builder uses the first dataset to be added as the Study Description source but this can be changed as desired. To specify a different dataset:

1. Choose a dataset from the hierarchy
2. Click on the 'Use selected dataset as the Study Description source' button.
   Alternatively click on **Hierarchy | Use as Study Description source**.

**Note**: Ensure that the study description information to be used as the ‘source’ for the hierarchical study contains information relevant to the complete study, and not just to the specific file it is part of. The ‘ID’ entered in the Study Description Source file will be used for the complete study.

### 5.8.2 Cube Builder

A cube is a multidimensional table consisting of a number of dimension variables, and at least one measure variable. Dimensions define the structure of the cube, while measures provide the numerical values of interest to the user. Dimensions can be hierarchical such that data can be compared at different levels (e.g., at country level or town level). Cubes provide a powerful data-modelling tool because they allow the user to arrange the data display, and remove or add in dimensions or categories depending on the comparisons the user wishes to make. Data can also be mapped if the appropriate link is added and the map is provided by the data Publisher. Further information about the use of the Cube builder can be found in the user guide ‘Nesstar Cubes’ available from Nesstar Support.

### 5.9 Window

#### 5.9.1 Cascade

If two or more datasets are open, use the Cascade function available from the Window menu to view all the data sets at the same time in separate overlapping windows. You can resize these windows by clicking and dragging the edges of the windows with the mouse.

#### 5.9.2 Arrange Icons

The windows can be minimised to icons at the bottom of the main window. If you would like to place the icons somewhere else in the main window, you can drag them
using the mouse. Use Windows | Arrange Icons to move the icons back to the bottom of the screen.

5.10 Help

5.10.1 Homepage
Click on Help | Homepage to view the Nesstar Publisher’s homepage.

5.10.2 View Licence
Click Help | View Licence to display the Nesstar Publisher user licence.

5.10.3 Support
Use Help | Support to go to the Nesstar Publisher's support page on the internet.

5.10.4 Submit Bug Report
Use Help | Submit bug request to go to a web page that lets you enter and submit the details of any bugs you encounter in the Publisher.

5.10.5 Submit Feature Request
Use Help | Submit feature request to go to a webpage that allows you to suggest changes to the Publisher.

5.10.6 About
Click Help | About to open a dialogue box giving some technical details about this version of the programme.
Disclaimer:

While the University of Essex and the Norwegian Social Science Data Services (NSD) have taken all reasonable efforts to compile accurate documentation, we cannot accept liability for any loss or damage consequential or otherwise suffered by the client or any third party arising as a result of its use.